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Version 11 – November 21, 2016 – Design Office 11
A. Design Codes and Standards
Version 11 of Sizer updates several design codes and standards used in the program. The details of the
associated changes to the program appear elsewhere in this list of changes; this section just identifies the
design standards changed.

1. Standards Updated
The implementation in Connections of the IBC has been updated from the 2012 edition to 2015, the NDS from
2005 to 2012.

a) ICC International Building Code (IBC 2015)
Version 11 of Connections implements the 2015 IBC, whereas Version 10 implemented the 2012
version.

b) ANSI/AWC National Design Specification for Wood Construction (NDS 2015)
Version 11 of Connections conforms to the NDS 2015, whereas version 10 conformed to NDS 2012.

2. References to the Design Standard Editions
The references to design standards have been updated in the following places:

a) Welcome, About Sizer, and Building Codes Dialog
The new design standards implemented are listed in the Welcome dialog box that appears on program
start-up, and can be invoked later via the Help menu, and in the About Connections box from the Help
menu. More detailed information is given in the Building Codes dialog box invoked from the Welcome
box.

b) On-line Help
The On-line Help documentation has been updated to refer to the current design code editions.

3. References to the Design Standard Clauses
Where necessary, references to design code clause numbers in program messages, notes, results output, etc.,
have been updated, as follows.

a) NDS
In the NDS, the chapter numbers for Connection design were incremented by 1, so that references to
Chapter 10 are now to Chapter 11, Chapter 11 to Chapter 12, and Chapter 12 to Chapter 13. The
references to the following clauses were accordingly updated: 12.1.1, 12.1.4, and 11.5.1.3.

b) On-line Help
The design code clause references that may have changed have not yet been updated as within the Online Help as of the date of the software release. The Help is now accessed over the Web, and will have
the updated references, if any, by Feb 2017.

4. On-line Design Standards
The WoodWorks package no longer installs a .pdf file for the On-line NDS on your computer. The Help menu
links and Start menu icons now direct you to websites where viewable versions of the NDS and NDS
Supplement are accessed.
Note that the NDS Commentary is no longer included.

B. Engineering Design
1. Canadian Design Code in Output (Bug 3122)
The reference to the Canadian CSA O86-14 design standard in the design results output at the start of the
calculations has been changed to NDS 2015.

2. C∆ Factor for Orthogonal and Skew Bolted Connections (Bug 3158)
When determining the C∆ factor for end distance from NDS 11.5.1.2 9 (c) for orthogonal and skew connections,
the program considered only the end distance for the main member. For example, for orthogonal correction
with loads in one direction, the program did consider the perp-to grain C∆ factor when it is less than the C∆ for
the main member. In addition, sometimes the program miscalculated the end distances used to determine the
factor.
The program now calculates C∆ factors for both members, and uses the worst-case value. The problems in
calculating the end distances have also been corrected.

3. Inset on Side Member for Bolted Orthogonal Connections (Bug 3160)
For orthogonal bolted connections with an inset side member, there was a minimum edge distance calculation
error and the smallest bolt could not be used in the design, when it should be allowed. This has been
corrected.

C. Program Operation
1. On-line Help
a) Web Help
The On-line Help is no longer accessed from a file installed on your computer; it is now accessed via the
Web. The Help will now be updated with corrections and for changes to the program as they occur.

b) Update for Version 11 Changes
The On-line Help has not yet been updated for the changes for version 11 described in this document.
The Help will have the updated descriptions by Feb, 2017.

c) USA-specific Help
The Help is now specific to the USA version of the program. References to Canadian design procedures
and program operation have been removed.

2. Bug Fixes and Small Improvements
a) Invalid Keycode Message (QA Change 1)
The message that appears saying your keycode is invalid now directs you the WoodWorks Sales email
address.

b) Product Code in Software ID (Feature 13)
The three-digit code in the software ID that identifies the software version has been expended to 5 digits.

c) Information in About Connections box
In the About Connections box accessed from the Help menu:
Misplaced colons and brackets in the design code and standard sections have been removed.
In the sales and tech support sections, email communication has been emphasized over phoning, phone
extensions were added, the fax number was removed, and the website is now a link to the site rather
than text.
The words WoodWorks Technical Support were mistakenly removed, and have been put back.

d) Network Installation Error (Bug 3151)
Occasionally, when running the software from the network installation the program would fail, giving the
following error message: "When running from a server, the initialization files must be in the 'Common
Application Data' folder, refer to the documentation for information network installation.

Previous Versions
An asterisk (*) indicates that the item entered this document after the version was released.

Version 10.4 – August 6, 2015 - Design Office 10, Service Release 4
1. Bolted Steel-to-Wood Splice Connection Design (Bug 2908)
For the bolted steel-to-wood splice connection did not function correctly when the bolt diameter is less than
one inch and there is more than one fastener per row. If the rows per plate was set to 1, an Internal Error
message was displayed, and if rows per plate was set to unknown or a value greater than 1, the group factor
Cg was incorrect. These problems have been corrected.

2. Orthogonal Bolted Connections Design Failure (Bug 2951)
For orthogonal bolted connections, if the main member is not loaded, and the main member width is much
smaller than the side member, then the connection design failed with any load. This has been corrected.

3. Unloaded Edge Distance for Bolted Skew Connection (Bug 2993)
For bolted skew connections, when spacing between rows is specified for the side member, the unloaded edge
distance on one side became significantly larger than the other, so the bolt array was asymmetric within the
side member. The unloaded edge distance should be the same on both sides.
This was an issue only with positioning the fasteners after design and did not affect the edge distance used to
determine how many fasteners are possible or, and has been corrected.

4. Design Failure for Bolted Skew Connection with Large Overhang (Bug 3055)

For a bolted skew connection, a positive side member overhang can be increased so that it causes
the program to report that the connection is too small to accommodate even one fastener, even
though it could do so with a smaller overhang. Several errors contributed to this problem, such that it
is likely that there were other problems with the calculation of possible configurations within this
connection. These problems have been corrected.
5. Lapped Shear Nail Connection Internal Error (Bug 3045)
For lapped shear connections, if the area of intersection between members is too small to allow even one nail
of any size, or If the thickness of the members does not allow for minimum penetration, the program reported
an Internal Error message instead of an informative error message.
The messages that now appear are as follows:
- If the area of the intersection area between members is too small to allow the selected details to
perform a design:
Current set of fastener selections is not valid
Nails not available because a member is not wide enough to satisfy minimum edge distance
and spacing:
If the nail details are left as unknown, however, the area of intersection between members is too small
to allow even one nail of any size:
Invalid Method
Nails not available because a member is not wide enough to satisfy minimum edge distances.
- If the thickness of the members do not allow for minimum penetration:
Nails cannot be used with the current set of main and/or side member selections
Nails are not available because the side member is too thick to allow the largest available nail to
penetrate the main member.

6. Tip Length for Penetration Depth for Lag Screw Connections (Bug 3050)
The penetration depth used for lag screw withdrawal resistance subtracted 1/2 the tip length from the main
member, when it should have been subtracting the full tip length. Clause 11.3.5.2 mandating 1/2 the tip length
applies to lateral dowel bearing length only, and although NDS isn't explicit about withdrawal lengths, Table L2
for lag screw lengths shows the length T-E without tip length, and physical reasoning excludes the tip length
from withdrawal contribution. The program now subtracts the full lag screw tip length.

7. Intermittent Bolted Skew Connection Design Failure (Bug 3046)
For particular sequences of user operations the lapped skew connection failed to design and showed an
Internal Error on the input screen. This happened intermittently, and has been corrected.

8. Direction of Load Arrow for Perpendicular Wood-to-Concrete Connection (Bug 2620)
A positive load on the perpendicular wood to concrete connection, that creates a downward load on the
fastener group, is incorrectly shown as an upward arrow in both the bitmap image and the beam diagram. This
has been corrected on both drawings.

9. Bolted Ledger Connection Penetration Depth Label (Bug 2929)
Starting with version 10.2, for bolted ledger connections, the input field for Penetration Depth was displayed as
Width. This has been corrected.

10. Column-to-Base Plate Height Dimension in Diagram (Bug 3057)
The dimension lines for the main plate in the diagram of the column-to-base connection were showing
the width of the plate instead of the height. This happened for all fastener types and has been
corrected.
11. WoodWorks Sales and Technical Support Contact Information (DO Change 6)
In both the Key code Registration box and the Help About box, we have
 removed word Support from "Sales Support”
 asked users to provide company name rather than address,
 removed fax as a means of communication.

 emphasized email instead of phone as a means of contact
 changed the email address to be a link that opens an email message
 The words “WoodWorks Technical Support” were no longer above the tech support contact information.
They have been restored.

12. Parentheses in the Help About box (DO Change 7)
Where parentheses were used in the Help About, the closing parenthesis appeared inverted at the start of the
line instead of where it should have been. These occurred around things like the date of publication and the
relevant parts of design code publications, and have been replaced with a dash as a means of delineating
them.

Version 10.2 – October 8, 2013 - Design Office 10, Service Release 3a
The following correction was made in the Independent Connection Module (ICM) DLL files that are included in
the Design Office installation, so did not involve a change to the Connections program itself or its version
number.

13. Nail and Screw Tip Length (Bug 2900)
For nails and wood screws, when determining the dowel bearing length according to NDS 11.3.5, the
program subtracted a the full tip length of E = 2D, when it should have subtracted ½ the tip length, or D. This
has been corrected. This problem caused dowel bearing strengths to be roughly 5% less than they should be.

Version 10.2 – September 23, 2013 - Design Office 10, Service Release 3
1. Lapped Shear Wood to Steel Bolt Row Spacing (Bug 2853)
For lapped shear wood-to-steel bolt connectors, if the main member end type was set as extended, the upper
limit for row spacing shown in the dropdown box was based on the entire side member width rather than the
member width edge distance subtracted.
If you selected this larger value, the program is limited to fewer rows per plate than it should be, and the design
failed when an allowable design is possible. This has been corrected. .

2. End Distance for Bolted Lapped Shear Connection (Bug 2829)
When a negative force is applied to a member in a lapped shear connection, indicating that it is in
compression, the program was applying a minimum end distance of 10 bolt diameters rather than the 4 bolt
diameters given in NDS Table 11.5.1.A. This has been corrected.

3. Update of Details after Material Change (Bug 2781)
With the new user interface for version 10, a change in material size no longer triggered the update of the
Details selection lists for bolt size, spacing, rows and fasteners per row. This has been corrected and the
values in the dropdown list showing the limiting values for these parameters are calculated using the new
material sizes.
Please note that this system did not work perfectly in every instance with version 8, and whatever inaccuracies
that were in that version remain. In these cases, you must type in a valid value rather than selecting one from
the list

4. Mouse Wheel Scrolling of Results View (Bug 2581)
Starting with version 10, the mouse wheel no longer caused the results view to scroll. This has been corrected.

5. Saving Files Before Material Input is Complete (Bug 2520)
Starting with version 10, if the material input was not complete or invalid when the Connections project file was
saved, the saved file could not be loaded and a message appeared saying it was incompatible with
Connections .This has been corrected and files can now be saved at any stage in the input process.

6. Steel Plate Thickness (Change 36)
Steel plate sizes of 5/8”, ¾”, 1”, and 1-1/4” have been added to the selection list for post-and-beam
connections.

7. Welcome Box from Help Menu (Change 38)
You can now access the Welcome to Connections box from the Help menu, similarly to Sizer and Shearwalls.

8. Version in Title Bar for Open Files (Change 39)
When you had a file open, the title bar no longer had the version number on it. This has been corrected.

Version 10.1 – January 14, 2013 – Design Office 10, Service Release 2
This version was released to address the following problems in the program:

1. Failure Warnings and Messages (Bug 2692)
With the redesign of the Connections user interface for version 10, many warnings and messages that
indicated a connection was not available, or that it failed for some reason, that used to appear via pop-up
messages at various stages in the connection selection process, no longer appeared in the program. Instead,
a more generic message often appeared in the materials/details input screen.
In particular, two messages used to appear sequentially in Version 9, the second one giving the particular
reason for failure and possible remedies. This second message often did not appear in version 10, and as a
result it was often not clear why a connection was not available or failed, and what to do about it.
This has been corrected, and the messages that used to appear sequentially via pop-up dialogs now show
permanently in the materials/details input screen, until a change is made to allow a successful design.

2. Moisture Content
a) Persistence of Wet Moisture Content Input (Bug 2701)
When both the In-service and Fabrication moisture content are set to Wet and you shifted between the
Main and Side tabs, the software automatically switched the In-service moisture content back to Dry.
This has been corrected.
This is did not have design consequences as the CM factor is the same for both In-service =Dry and
Fabrication = Wet as for In-service = Wet and Fabrication = Wet.

b) CM Used for Moisture Content Inputs (Bugs 2699 and 2702)
Starting with version 10, the moisture factor CM value selected from NDS Table 10.3.3 for bolts, nails,
screws, and lag screws often did not reflect the moisture content selections in the Materials input. For
example, when in-service moisture content was specified as wet and fabrication was specified as dry, the
program would sometimes use a CM value of 0.7 rather than the required 0.4. At other times Note 2
requiring that CM = 1.0 for one row of fasteners was not applied.
The occurrence of these problems depended on the sequence of operations in the user interface. They
have been corrected and the correct moisture content factor CM is consistently used.

c) Moisture Factor for Nails and Screws Greater than ¼” (Bug 2765)
For nails and screws greater than ¼” diameter, the program was not implementing the second condition
of note 2 of Table 10.3.3 for wet fabrication conditions that assigns a factor of 1.0 when there is only one
row parallel to grain, and was instead implementing the 0.4 factor. This has been corrected.

d) Moisture Factor for Perpendicular to Grain Connections with One Fastener Per Row (Bug
2766)
In implementing the second condition of note 2 of Table 10.3.3 for wet fabrication conditions that assigns
a factor of 1.0 when there is only one row parallel to grain, the program mistakenly included
perpendicular to grain connections with one fastener per row. This has been corrected and these
connections now have a factor of 0.4.

3. Allowable Bolts for Splice Connection (Bug 2755)

For bolted splice connections, if a detail like bolt size is changed before the materials were completed an
internal error was shown on the materials screen, even if it was a valid detail.
If the design was performed with all details unknown, the program could design for example for a 1/2" bolt. But
if you then select that bolt size, the program issued an error saying bolts in general cannot be used (an
incorrect error message if the problem was in fact the bolt size).
Upon investigation, it was determined that the list of available bolts per row was often not correct, usually
showing fewer bolts than possible in the connection. .
These problems were a result of calculations for the minimum edge distance using the side member width as
the main member width and have been corrected.

4. Allowable Plate Size for Bolted Steel Splice Connection (Bug 2858)*
For steel to wood lapped shear splice connections, the program indicated that no design is possible after
reducing the steel plate size, even though it was clearly evident that there is enough room for one bolt to fit.
This has been corrected.

5. Maximum Rows per Plate for Bolted Splice Connection with Wood Side Plate (Bug 2779)*
In the calculation of rows per plate for bolted wood-to-wood splice connections, the program was using the
main member width for the width of the side member. As a result, the program was allowing either too many
rows, or too few when the members were of different width
6. Design Load Output for 2-Sided Connections (Bug 2749)
For the two-sided beam to beam connection, the program reported the factored design load in the design
results as the load on just one of the members, instead of the combined load on both members. This has been
corrected and the load is twice what previously appeared.
The design ratio shown is correctly based on the combined load.
7. Name of Materials/Details Window (Bug 2768)

When the Details button is pressed, the title of the window that appears was Material. This has been changed
to Materials and Details.
8. Labels for Member Width and Depth Input for Large Fonts (Bug 2689)

When large fonts are selected in Windows, the input label that should say Width b just said Width, and Depth d
did not appear at all. This has been corrected.

Version 10 – July 12, 2013 – Design Office 10
A. Design Codes and Standards
Version 10 of Connections updates several design codes and standards used in the program. The details of
the associated changes to the program appear throughout the rest of this list of changes, this section just
identifies the design standards changed.

1. Standards Updated (Feature 46)
The implementation in Connections of the NDS has been updated from the 2005 version to the to 2012
version, thus the IBC from 2009 to 2012, and the program has been updated to the AISC 360-10 from the 1989
ASD Steel Specification.

a) ANSI / AWC National Design Specification for Wood Construction (NDS 2012)
Version 10 of Sizer implements to NDS 2012, whereas version 9 implemented NDS 2005. There were
significant changes listed below.

b) ANSI / AISC 360 Specification for Structural Steel Buildings (AISC 360-10)
Steel design in Connections is from the 2010 AISC 360. Previous to version 10, the program
implemented the ASD Specification for Structural Steel Buildings from June 1 1989, contained in the 9th
edition of the Manual of Steel Construction. The AISC 360 supersedes the ASD Specification.

There were numerous and significant changes to steel design due to the implementation of the AISC
360, listed below.

c) ICC International Building Code (IBC 2012)
Via reference to the NDS 2012, Version 10 of Connections conforms to the 2012 IBC, whereas Version 9
conformed to the 2009 version.

2. References to the Design Standards
The references to design standards have been updated in the following places:

a) Welcome, About Connections, and Building Codes Dialog
The new design standards implemented are listed in the Building Codes dialog box invoked from the
Welcome box that appears on program start-up, and which can be invoked later via the Help menu, and
in the About Sizer box from the Help menu.
Note that the About Connections box previously showed design code information more appropriate to our
Shearwalls program (SDPWS and ASCE rather than AISC and NDS). This has been corrected.

b) Messages, Notes, and Results Output
The references in all informational and warning messages, and in the design results, have all been
updated for the new references.

c) Online Help
The Help documentation has been updated both with the new references and with any changes in
explanations needed.

B. Update to NDS 2012
1. Shear Reduction Factor Cvr
The program implements the new shear factor Cvr = 0.72 from NDS 5.3.10 for those aspects of Connections
that use the Fv value for glulam members. These are
 Row tear out
 Group tear out
 Effective shear capacity

Connections outputs this value in the Adjustment factor table of the Additional Data.
Note that this requirement is not new, it was previously mandated via a note in tables 5A-5D of the NDS
Supplement, however this note was not implemented in the Connections program.

2. Tip Length for Bearing Length for Lateral Resistance
As per 11.3.5, The program determines the bearing length into the main member, lm, for lag screws, wood
screws, and nails, as being the penetration into the member minus ½ the tip length. The previous rule is to
subtract the whole tip length for penetrations greater than 10D.
The tip lengths for the connectors are as follows:

a) Lag Screws
The value E from Appendix L, tableL2, which had not changed and was implemented by the program.

b) Wood Screws
2 diameters, from Table L3, which is new, but is the same value previously used in the program.

c) Nails and Screws
4 diameters, from Table L4, which is new, but is the same value previously used in the program.

3. Restrictions on Outermost Fasteners
A new set of restrictions on the perpendicular to grain distance between outermost fasteners loaded parallel to
the grain from Table 11.5.1F has been implemented. These restrictions are particular to glulam, but we have
also modified the way Connections handles similar restrictions for all other materials.

a) Glulam Restrictions

The requirements for glulam from table 11.5.1F providing larger maximum distances than the 5”
maximum in Figure 11H for other types of wood (10” for bolts and 6” for lag screws). Note that for wet
service or wet fabrication conditions, the maximum remains 5”.

b) Warning Message
Previously the restriction for all materials was imposed on the design such that it was impossible to
select a set of fasteners that violated the restriction. This restriction was applied to fasteners wooden
members loaded in tension only. Now, the program applies allows fastener groups wider than the
maximum but issues a warning message recommending special detailing to accommodate shrinkage.
The warning message applies whether the wood is loaded in tension or compression.

c) Fasteners Affected
The fasteners affected are bolts, lag screws, and the few nails with diameters greater than 0.25” ( 6” and greater
common spikes for example).

d) Geometries Affected
i. Post and Beam
All post and beam connections with parallel to grain design, unless the main member is made out of
OSB or plywood. The members are thus





Column in Beam to Column Top
Both members in Beam to Column
Column in Column to Base
Purlin in Beam to Column,

ii. Steel to Wood Lapped Shear
All steel to wood lapped shear with a member loaded axially, unless that member is made of OSB
or plywood, are included.

iii. Wood to Wood Lapped Shear (Bug 1588)
Either or both members in orthogonal or skew wood to wood lapped shear that is loaded axially,
unless it is made of OSB or plywood.
An axially loaded splice wood to wood member that is loaded axially only if the other member is
plywood or OSB, otherwise the splice connection is not included (as both members will shrink in
unison).
Note that previously the program had been applying the restrictions to all wood to wood splice
connections. This has been corrected.

e) Removal of 12” Limitation (Change
Previously, the program implemented a restriction that the perpendicular to grain distance of fasteners in
row loaded perpendicular to the grain could not be greater than 12”. This was not a design code
restriction, but based on recommended practice. It has been removed from the program.

f) Removal of Maximum Rows Limitation
Previously, the program implemented a restriction that the maximum number of fastener rows either
perpendicular or parallel to grain could not be greater than a number given in the initialization file,
defaulting to 5. This was not a design code restriction, but originally implemented to ensure that the
program did not generate a large number of fastener rows. Since that time, other methods were
developed to limit the generation of fastener rows, so this limitation has been removed.

4. Geometry Factor CΔ for Shear Plates
The program implements changes to Table 12.3 specifying minimum edge and end distances, and the
distances for which the geometry factor CΔ is applied.

a) Minimum Unloaded Edge Distance
The minimum unloaded edge distances have been changed to equal the minimum unloaded edge
distances for CΔ = 1, effectively removing the CΔ for unloaded edges. These minima have increased from
1½ “ to 1¾ “ for 2-5/8” connectors, and from 2½ to 2¾ for 4” connectors.

b) End and Edge Distances Loaded at an Angle to the Grain

Using NDS 2005, 12.3.3.2 and 12.3.4.2 allowed you to interpolate between edge distances and end
distances for perpendicular and parallel to grain loading. These sections have been removed, and
section 12.3.2.2 in 2012 says separate factors are to be computed for the parallel and perpendicular
components. Connections now implements a conservative interpretation that end and edge distances are
to be applied separately, so that the worst case is used, which is perpendicular for edge distances and
parallel for end distances.

c) Design Code References
Notes in the Design Results now give 12.1.1 – 12.2.4 as the range of references, whereas previously it
was 12.1.1 - 12.2.3.

C. Update to AISC 360-10
In addition to the substantive changes given below, there have been numerous changes in nomenclature and
formulation between the 1989 ASD Specification and AISC 360-10. Only those changes that result in a
different value being calculated are given here.

1. Shear in Plate at Bolts and at Welds
The program now implements AISC 360 J4.2, including Eq J4.3 and Eq J.4.4, whereas it previously
implemented ASD 89 F4 and Eq F4-1. Shear Yield (J4-3) is the same as old equation (F4-1); we added the
shear rupture equation (J4-4). The program checks for net area at the weld, and compares to the gross area
check for worst case.

2. Shear in Weld
The program now implements J2.4(a), Including equations q J2, J4 and J5, and Table J2.5, which allow you to
take into account the angle between the load and the weld.

3. Bolt Bearing on Plate
The program now implements J3.10 and Eq.J3-6a., whereas previously it implemented J3.7, including Eq.J3-1
and Eq.J3-3. The difference is that one of the conditions used a value of Le the, distance from centre of hole to
the plate edge , whereas now it uses a value of lc which is the distance from edge of hole to adjacent hole or
plate edge. So spacing to a neighbouring hole is now taken into account, and the distance to plate edge is
reduced by one half the hole size to reflect lc instead of Le.

4. Shear in Bolt
The program now implements J3.6 and Table J3.2 with footnote c as opposed to J3.4 and Table J3.2. The
effective differences are that the ASD Fv / Fnv value has increased from 10 ksi to 13.5 ksi, and that footnote c in
Table J3.2 requires a 1% reduction in shear resistance for each 1/16” that the width of connected parts is
greater than 5d.
Since the program would fail every time for larger member sizes ( about 8.5” for ½” bolts), we placed a lower
limit based on the Table J3.2 entry for all bolts meeting requirements of A3.4, including. A307. This is 0.45Fu ,
where Fu = 36 ksi, conservatively assuming that the threaded portion of the bolt is in the shear plane.

5. Tension in Bolt
The program now implements J3.6 and Table J3.2 as opposed to J3.4 and Table J3.2. The effective
difference is that the ASD Ft / Fnt value has increased from 20 ksi to 22.5 ksi..

6. Combined Tension and Shear
The program now implements J3.7, Table J3.2 and Eq J3-3a,b as opposed to J3.5 and Table J3.3. The
effective difference is that the ASD Ft / Fnt value has increased from 20 ksi to 22.5 ksi and the ASD Fv / Fnv
value has increased from 10 ksi to 13.5 ksi.

7. Minimum Bolt Edge Distance
The program now implements Table J3.4 as opposed to J3.9 and Table J3.5. Previously we were using the
“sheared edge” requirement on the assumption that the plates were punched, buit the new code does not
seem to have the distinction between sheared and rolled edges and all distances are the previous rolled edge
values .

Minimum edge distances have been reduced from 7/8” to ¾” for ½” bolts; from 1-1/8” to 7/8” for 5/8’ bolts; from
1-1/4” to 1” for 3/4” bolts; from 1-1/2” to 1-1/8” for 7/8” bolts, and from 1-3/4” to 1-1/4” for 1” bolts.
The extra requirement in J3.9 of 1.5 D for multiple bolts along the line of force has been removed.

8. Unit Weld Strength Value (Bug 2548)
The program was using a weld strength of 145 kN/mm weld thickness/mm weld length instead of the correct
102, which is a direct conversion of 0.928 kips/16th inch weld thickness/inch weld length from values in Table
J2.5 in AISC ASD 1989. This error meant that where weld strength governed, the weld size was too small.
Note that the weld strength in has not changed using J2.4, Eq J2-3 and Table J2.5 of AISC 360-10, so that
fixing this bug brings the program into conformance with then new design code as well as the old.

9. Minimum Bolt Spacing (Bug 2589)
The minimum distance between the centers of bolt holes in a steel plate is 2-2/3 bolt diameters according to
J3.8 of the 1989 AISC code, and J3.3 of the AISC 360-10 code. The program has always implemented 2
diameters rather than 2-2/3, so that bolt rows were spaced too closely together to satisfy steel design criteria.
This affects the spacing of bolt rows that is the unloaded direction, as the minimum wood requirement is 1.5D
(we implement 2 for practical installation reasons). Along a loaded line, the minimum is 4 so the steel minimum
does not come into play.

10. Combined Bolt Tension and Shear Failure Indication (Bug 2590)
In determining whether the steel design check for combined tension and shear in the bolts failed, the program
compared the combined tension resistance to the tension resistance, rather than the tension force. As the
combined tension resistance using section J3.5, from the 1989 AISC code is always less than the tension
resistance, the check never failed.
Note that the program presented the correct numbers in the design summary; it is just that it would not indicate
a failure when there was one.
This has been corrected so that the program does indicate failure when it occurs using J3.7, Table J3.2 and
Eq J3-3a,b of the AISC 360-10 code.

11. Allowable Bearing of Bolts on Steel Plate (Bug 2591)
The program was always applying equation J3-3 of the AISC 89 steel design code for allowable bearing of
bolts at bolt holes in steel plates, even though it is applicable only to the case where there is only one bolt in a
row, or the edge distance is less than 1.5D. As J3-3 governs for edge distances between 1.5D and 2.4D, it was
being applied in that range when it shouldn’t have been for multiple bolts in a row.
This is a conservative error as this equation gives a lower resistance than the alternative, equation J3-1.
As this condition is no longer applied in J3.7 of the AISC 360-10 design code, update to that code has
eliminated the problem.

D. Other Engineering
1. Net Section of Column to Base Connections (Bug 2606)
For column to base connections, the program was using the member width rather than the member depth to
determine the area deducted by the bolt holes to create the net section. This affected the calculations for net
tension resistance required by NDS 3.1.2 for bolts and shear plates, and has been corrected.

2. Orthogonal Connection End Distance for Row Shear and Group Tear-out (Bug 2475)
The end distance used for the calculations for bolted row shear resistance (10.4.4.4) and group tear-out
(10.4.4.5) for orthogonal connections was the minimum end distance as input in the Details screen, rather than
the actual end distance designed by the program. As a result the row shear and group tear-out resistance were
almost always underestimated, which may causes over-design or failure to provide design to resist the applied
force when a design exists.

3. Multi-ply Member Design for Bolted Lapped Shear Steel to Wood Connections (Bug 1914)
The main member thickness used in lateral strength resistance for bolted wood to steel lapped shear
connections with multi-ply main member was based on single ply regardless of the number of plies selected,
so that the resistance calculated was too low by a factor equalling the number of plies when the main member
yield modes govern. This has been corrected.

4. Positioning of Fasteners in Orthogonal Connection with Inset or Overhang (Bug 2470)
The bolts in an orthogonal connection with main member inset or over hang were positioned too close to the
lower edge of side member. A similar error occurs for side member inset, in which case fasteners are
positioned very close to the end of side member. This has been corrected.

5. Group and Row Checks for Extended End Lapped Shear Connections with One Bolt Per Row (Bug
2408)
When there is just one bolt per row on the group tear out and row shear checks for connections with extended
end types, the program applied a wildly high resistance based on 10,000 inches end distance. Now, the Group
and Row Tear out checks are not applied for these connections.

6. Load Duration Factor for One Load on Member (Bug 2308)
When there are two loads with different load durations, the load with the shortest duration is used to find the
duration factor CD in accordance with NDS 2.3.3.2. However, the program was including the duration input of
loads that were not entered and had a magnitude of zero to determine the duration factor. This has been
corrected.

7. Failure for Unknown Offset (Bug 2289)
For the lapped shear connections, if an offset was left as unknown, connections would often fail when it was
possible to achieve a passing design with a legitimate offset. This has been corrected.

8. Removal of Restrictions
Several restrictions that were not based on design code requirements were removed from the program:

a) 12” Distance Between Outermost Fasteners (Change 31)
Removed the restriction that fasteners loaded perpendicular to grain cannot have a greater than 12”
distance between the first and last fastener in a row.

b) Maximum Number of Rows (Change 32)
Removed the setting in the initialization file that limited the maximum number of rows in a connection.
The default value was 5. Now any number of rows can be made.

c) Distance from Top of Plate to Top of Member (Change 33)
Removed the restriction that the edge of a plate that is unattached to any other steel plate must be at
least ½” from the edge of a member. It can now extend right to the edge of a member.
Had we kept this restriction, the new reduced C-delta for unloaded edge would not be possible for beambeam and beam-to-column top connections.

E. User Interface Reorganisation
The Connections user interface has been completely revamped to make it easier and quicker to view, select,
and design your connections.

1. Sequence of Operations
The program operation has been streamlined so that you do not have to create a new file just to see all the
connection possibilities or change your connection. You just select from either a list of all Connections in a
“tree” list or in a view containing images of the connections.

2. Connection Tree
At any point while inputting data, by clicking the “Geometry” button you can see a “tree” of all possible
connections, and to select from that tree to change your connection type. The lower branches of the tree
invoke views that show images of all Connections along that branch.

3. Details and Materials Screens
The previous details, materials, and geometry screens have now been combined into one screen, so all input
can be viewed at once.

4. Input Diagram

The program shows the diagram of the connection while you are inputting data, updating it to show the
meaning of the various fields such as “offset”.

5. Real Time Design
The program redesigns the connection automatically upon any change in the materials or loads input. When
connections details change, it is necessary to press the “Run Design” button.

6. Error Messages and Warnings
Error messages and warnings that used to appear via pop up messages now appear in the main input screen
as they occur without interfering with further input. They are coloured red for visibility.

7. Miscellaneous User Interface Items
a) Version Number in Program Name (Change 18)
Connections now has the version number in the name of the program that appears in the program title
bar, and over icons that appear in the start menu. This enables you to quickly identify the version of the
program you are running.

b) Width and Depth Nomenclature (Change 19)
The letters b and d for input breadth and depth of the members in a lapped shear connection have been
changed to Thickness and Width. These designations caused confusion because the b dimension in the
usual b x d nomenclature is the d dimension for connection design. The post and beam connections
have been renamed Width b and Depth d to make it clear what is meant by b and d, which are shown in
the pictures identifying some of these connections.
c) Tolerance for Checking Equal Member Sizes for Beam to Column Top Connections (Change

30)
The program compares the two members in a beam to column top connection using floating point
accuracy to determine whether they are the same size. For this reason, multi-ply members that would be
the same nominal thickness as a single member are not considered the same thickness because of
metric conversions, and you would not be allowed to design the connection. This has been corrected by
applying a ¼” tolerance when comparing the member thicknesses.

d) Fabrication Moisture Conditions for Concrete Side Members (Bug 2467)
The Fabrication Moisture Conditions remained active for concrete side members, when other, similar
controls that are not relevant to concrete were disabled. This has been corrected and the fabrication
conditions are not active for concrete members.

e) Ledger Board Name (Change 16)
The member name "Ledge" has been changed to "Ledger board", as has the Connection type with that
name.

f) Status Bar Message for Skew Connection Angle (Change 17)
The status bar message for angle input for skewed connections has changed to inform users that a 180
degree range of input is allowed, exclusive of 90 degrees.

g) Design Code Information in Welcome Box (Bug 2521)
In the Welcome box, the design code information for Canada appeared in a greyed out form, and has
been removed. The USA design code information is available via the Design Codes button.

h) Help File Menu (Bug 2359)
The problems with the Help menu that were described as fixed for version Version 9.2 below reappeared
in version 9.3. They have been corrected again for version 10.

F. Output and Drawings
1. Load Arrows (Feature 32)
Arrows showing the direction and magnitude of loading are now shown on the diagrams for all connections.

2. Additional Data Display Setting (Change 8)

A setting was added to the Settings menu that shows or hides the additional data in the output, such as the
adjustment factors and yield mode values used in intermediate calculations.

3. Fixed Number of Decimal Places in Output (Change 9)
All numbers appearing in the same column in the Design Results output now have a fixed number of decimal
places. In previous versions, the numbers would have fewer decimal places than normal if the least significant
digit was zero.

4. Output Format for Wood-to-Wood Connections (Change 11)
Connections with two wooden members previously outputted the results for the two members in a separate
column for each member. Now only one column is used and the results are split into a different section for
each member.

5. Resistance to Load Ratios in Output (Change 12)
Ratios were added in the output for quick visual comparison between the design load and the resistance.

6. Reformatted Output for Combined Loading (Change 13)
The output for bolts and lag screws under combined parallel and perpendicular loads has been reformatted to
show the parallel-to-grain load before the tension, row tear-out, and group tear-out capacity. This enhances
readability as these values are to be compared to the parallel-to-grain load, not the combined load.

7. Names for Combined Load and Connection Capacity for Shear Plates (Change 15)
For shear plates in combined-load situations, the Factored Load and Connection Capacity variables have been
renamed in the results to N and N', respectively. They were formerly labeled as Nf and Nr.
8. Print Details in Initialisation File (Bug 2551)

The "PrintDetails" option under "[SteelDesign]" was removed from the .INI settings file, as this option can be
directly set in the View menu

Version 9.3 – March 18, 2013 – Design Office 9 Service Release 3
There were no changes to the operation of the program for this version. The following changes were
made to the installation of the program:
1. Version Number in ICM DLLs
The Independent Connection Module (ICM) DLLs that are included in the installation now contain
the same version number as the program because a new version number is required by the
installation package before it will install these components on top of an existing installation. This
has no effect on existing installations; it recorded here for technical reasons.
2. Initialization File Icon
The icon that allows you to access the connections initialization (INI) file to change program
settings has been restored to the Start Menu group for Design Office, under the Read Me subgroup. Since version 9.1, this has only been available through the Connections program View
menu.

Version 9.2 – June 4, 2012 – Design Office 9 Service Release 2
The following change has been made for this service release:
1. Help File Menu Items
Previously, the items that appeared when the Help menu item was selected were
Using Help
Contents…

When either of these were selected, the program did not invoke the Connections help file.
Now, the following menu item appears:
Connections Help…
When selected, the Connections Help now appears.
2. Arrows in Connection Identifier Images (Change 22*)
The arrows in the images identifying orthogonal connections have been changed to correspond
with the forces as they are input into the program. Previously they showed an upward force on the
side member, now they show a downward force on the main member.

Version 9.1 – July 27, 2011 – Design Office 9 Service Release 1
The following changes have been made for this service release:
1. Program Data Location
Because Windows 7 and Windows Vista operating systems do not allow write access to the
Program Files folders to those users who are not running the program as Administrator,
making it impossible for them to save changes to the material database or initialization files,
these files are now placed in a new location by WoodWorks.
It was also necessary for those users who were not administrators on their computers to enter
a key code each time the program was run.
These restrictions were more severe on Windows 7 than Vista.
The program now stores the support files for the program in the following folders
Windows 7/Vista:
C:\Users\[username]\AppData\Local\WoodWorks\CWC\USA\9\
Windows XP
C:\Documents and Settings\[username\]Local Settings\Application
Data\WoodWorks\CWC\USA\9\
The program also saves the files to the following folders:
Windows 7
C:\ProgramData\WoodWorks\CWC\USA\9\
Windows XP
C:\Documents and Settings\All Users\Application Data\WoodWorks\CWC\USA\9\
These are repositories for the files to be copied to each new user’s data folders when they first
use the program. This allows a system administrator to install the program, but others to use it
without restrictions.
A more complicated set of procedures for the network installations is described in the Network
Installations section above.
2. DLL Module Registration
Connections connection modules (.DLLs) no longer require being registered with the Windows
operating system, removing the need for the Connect.reg file and re-registering if you have
more than one edition of Connections on your computer.
3. New Installation
Refer to the Design Office readme file for details on the new installation package for
WoodWorks. Note that the Connections.ini file that is needed to modify design defaults (see

Customizing Connections, above) is no longer accessed via an icon in the Start menu group,
and must be invoked from the Connections program View menu instead.

Version 9.0 – October 27, 2010 – Design Office 9
No changes to the version of Connections included with Design Office 9

Version 8.2 – November 23, 2009 – Design Office 8 Service Release 2
No changes to the version of Connections included with Design Office 8 Service Release 1.

Version 8.1 – Feb 25, 2009 - Design Office 8 Service Release 1
The following issues have been addressed with this service release:
1. Bolted Lapped Shear Connections
a) Overhang Settings
Fixed numerous problems with the Orthogonal and Skewed Lapped Shear connections
calculations of minimum/maximum end and edge distances, allowable numbers of bolts,
rows of bolts, and bolt/row spacings, when overhang offsets are specified other than the
default configuration where the member ends are flush against each other. This
resulted in restricted numbers of bolts/rows, incorrectly positioned bolts, and disallowed
designs that should be valid.
a) "Invalid Connection Geometry” Message for Orthogonal Connections (Bug 1882)
A message that the geometry is invalid appears when designing certain orthogonal
lapped shear connections that specify an Overhang or Insert of the main member, even
when the geometry passes the requirements of the NDS Table 11.5.1A.. This was due
to the overhangs mentioned above.
b) Skewed Connections
 Connections was incorrectly calculating the end / edge distances, and allowable
number of bolts / rows, under some configurations of tension/compression and
acute/obtuse angle of connection.
 Connections was sometimes allowing you to specify a number of bolts that would
just fit using minimum end/edge distances and spacings, but would report "invalid
configuration" when design was invoked. This was due to the way connections
increments through spacings, sometimes the steps would not land within the
allowable range of spacings if the range was small enough.
c) Wood-to-Steel Connections
The number of bolts in a row and the number of rows of bolts for wood to steel lapped
shear connections were sometimes restricted to too few due to errors in determining the
available connection area which was calculating too small an area.
d) Wood-to-Wood Orthogonal Connection
Orthogonal lapped shear connections loaded in compression were determining
minimum end and edge distances incorrectly, sometimes returning distances as if they
were loaded in tension. This also affected the number of bolts/rows allowed in the
connection.
e) Compression End Distance (Bug 1887)
Attempting to design a bolted wood- to-wood lapped shear connection loaded in
compression with a specified end distance of 4 x bolt diameter resulted in an "invalid
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3.

4.

5.

6.

fastener geometry" message, but selecting "unknown" end distance successfully
designs using 4 x diameter. This has been fixed.
f) Orthogonal Wood-to-Wood Cg factor
For orthogonal lapped shear wood to wood connections the Cg factor for the side
member was not using the area for perpendicularly loaded members (CSA O86
10.3.6.3).
All Bolted Connections
a) Bolt Design Search (Bug 684)
When bolt size is "unknown", the program starts its design search with a bolt size
indicated in the program initialization file. If a design is not found with larger bolts, it is
supposed to go back and try smaller bolt sizes, but was not doing so unless no bolt
configuration with the larger bolts is possible. If such configurations were possible but
failed, the program would not return and try smaller bolts.
As a result, Connections would, for example, report design failure one 3/4" bolts when it
is possible to achieve a passing design with two 1/2" bolts. This has been corrected.
b) Bolt Positioning Tolerance (Bug 1888)
When determining the maximum number of bolts per row can be fit into a connection a
tolerance of 0.5mm is applied. In connections with several bolts per row, this tolerance
would accumulate and could result in bolts positioned such that their reported end/edge
distances were smaller than those used for design, and a failing configuration could be
accepted. This has been fixed.
Ledger Connections
a) Allowable Shear for Ledger Connection (Bug 1804)
The Connections software was calculating a factored yield limit for Mode IIIs of 30% of
the value derived by the Yield Limit Equations in the NDS 2005 for the ledger
connections. This was a unit conversion issue and has been fixed..
b) Concrete- to -Wood Connection Embedment Depth
You can now enter the bolt embedment depth for wood to concrete connections, that is,
the penetration distance of the bolt into the concrete. The program was previously using
6” for all connections. This value is used in the bolt yield strength equations.
Reporting of Tension Capacity, Net Area (Tr) Failure (Bug 1857)
The program was not properly indicating failed design due to the tension capacity net area (Tr)
check. It displayed a message box saying “Unable to design connector: error in design
routine", and did not output design results. The program now shows all the other design results
along with a prominent warning that the net area check failed.
Service and Moisture Conditions
a) Moisture Content Selection and Resulting Moisture Factor
In the Moisture Content section of the Load Material view, there were four choices for
each of Service and Fabrication condition, with each set of choices redundantly allowing
for service and fabrication moisture contents. The selection of Service conditions had no
effect on the value of the service condition factor Ksf, and the selection of Fabrication
conditions does not create factors in accordance with CSA 086 Table 10.2.1.5.
The program now has two choices for each of Service (wet, dry) and Fabrication
(seasoned, unseasoned) conditions, and the correct factor for the set of choices is
applied.
b) Service/Fabrication Conditions Input
The input control for In-Service and Fabrication moisture conditions did not allow
enough space for the lengthy strings such as Dry/Unseasoned, to the point that the
words 'seasoned" and "unseasoned" were not recognisable. This has been fixed.
User Interface and Results
a) Two-sided Connection: Member Selection and Title (Bug 17)

b)

c)

d)
e)

Connections highlighted the selection of purlins in a two-sided connection with different
shades of gray, leading one to believe the members and loads entered can be different,
when they cannot. Also, "two-sided" was spelled incorrectly in the title of the output
reports, as it was missing the hyphen. This has been fixed.
Extra Beam Hanger Dropdown Box (Bug 1024)
Beam Hanger with Shear Plates in Details view had an unlabelled dropdown box with
no choices. This box should not appear for column connections without loaded ends
and has been removed.
Significant Digits in Design Results (Bug 1022)
Some design results did not display their results to the number of significant digits that
are calculated (e.g. 3 should be 3.000)
Concrete-to-Wood Connections Name
Wording "Concrete-to- wood" wasn’t really accurate, changed to "wood- to-concrete".
Load Entry Label
For orthogonal lapped shear connections the label of the disabled force direction in the
load entry area was always showing the X –direction. It now shows the load direction
that cannot be entered given the connection type.

Version 8.0 - March 5, 2008 - Design Office 8
No changes to the version of Connections included with Design Office 8 from Design Office 7.

Version 7.0 - November 8, 2006 - Design Office 7
A. Design Codes
1. Design codes referenced
a. Design Codes box
Updated explanation of design codes referenced in Design Codes box accessed
from Welcome box.
2. On-line Design Code
a. NDS On-line
An updated NDS 2005 on-line .pdf document is accessed from Connections Help
menu, and status bar description. The NDS 2005 and NDS Supplement and
have been combined into one document, and the NDS 2005 Commentary is now
added in the same document
3. NDS 2005
Compared NDS 2005 design standard with NDS 2001, found no changes relevant to
the WoodWorks Connections Program
B. Lag Screws
The program now includes lag screw fastener modules designed according to dowel–type
fastener design in NDS 2005 - Chapter 11, and specifically 11.1.3, 11.2.1 and 11.4.1. The
program implements lateral (11.3), withdrawal (11.2) and combined lateral and withdrawal
(11.4) wood design provisions, and shear and tension steel design of the fasteners.
1. Connection Modules
a. Available Geometries
The program limits the use of lag screws to one-sided post-and-beam
connections, to avoid the complication of overlapping penetration, and because
bolts are more commonly used in two-sided connections.

One-sided beam-to-beam, one-sided beam-to-column, and sloped beam-tobeam geometries are therefore implemented. Lag screws are not available for
column-to-base, beam-to-column top, or lapped shear connections.
b. Method and Details Views
For these geometries, the lag screw option is available as a new choice in the
Connections Method view, and has it’s own set of Details.
c. Side plates
Lag screws are not used for the side plate design, this being a two-sided
connection. Bolts are used for the side plates when lag screws are used for face
plates.
2. Lag Screw Dimensions
The program uses the lag screw dimensions from NDS 2005 Appendix L, Table L2, pg.
166 as follows:
a. Input parameters
Diameter and length are used as the choices of available input parameters. They
can be unknown, but are restricted to the standard diameters and lengths (it is
not possible to type in custom sizes). They are also restricted by connection
geometry.
The diameters range from ¼" to 1-1/4"; the lengths depend on diameter and
range from 1" to 12".
b. Design parameters
Diameter, length, root diameter, unthreaded shank length, and tip length from
Table L2 are used for design.
c. Drawing parameters
The head width and height are used for drawing only. Threads are not depicted.
3. Geometric Limitations
The program implements geometric limits at the following times:
 upon validating the materials to determine the available methods for the
connection
 during input to produce the drop-down lists of available fastener parameters
 during design when resolving unknown values
a. Spacing
The program applies end and edge distance, and fastener and row spacing rules
for lag screw connections according to NDS Tables 11.5.1A-D. They are applied
identically as for bolted connections. These rules are used to populate the dropdown lists of fastener and row spacing and edge and end conditions
b. Protrusion and Minimum Penetration
The program prohibits lag screws from protruding through the main member
while ensuring they meet the minimum penetration of 4D into the main member,
according to NDS 11.1.3.6. These rules are used to populate the drop-down lists
of available screw diameters and lengths.
4. User Interface
a. Methods View
Slightly different pictures are used for bolt and for lag screw connections, and
labels have been added next to each selector button to avoid confusion. Titles
and descriptions were modified to refer to lag screws.
b. Details View
This view is the same as that for bolts except for the addition of lag screw length.
The available lengths are linked to the available diameters by Table L2. The
lengths are also limited to those that satisfy the minimum penetration and
protrusion rules for the connection geometry; indirectly also limiting the available
diameters.

Details view will not appear if there are no lag screws satisfying the geometric
limitations.
c. Warning messages
All warning messages were changed to refer to lag screws when appropriate.
d. Status bar messages
All explanatory messages in the status bar were changed to refer to lag screws
when appropriate.
5. Lateral Design
a. Calculation of Z
The program calculates lateral design capacity Z for lag screw connections
according to NDS 11.3.1, in a similar manner to bolts except as noted below:
b. Calculation of Z’ - Adjustment Factors
As with bolts, the load duration factor CD, service condition factor CM,
temperature factor Ct, group action factor Cg , and geometry factor CD and are
applied to lag screw lateral connection capacity according to.3.2, 10.3.3, 10.3.4 ,
10.3.6 and 11.5.1 respectively, and to Table 10.3.1. The fire retardant treatment
factor input by the user is also applied.
Note that the Cg factor is not applied to lag screws greater than 1" – these
fastener sizes are not included for bolts.
c. Diameter
Unlike bolts, the root diameter Dr of the lag screw is used in the yield limit
equations in Table 11.3.1A, not the full diameter D.
d. Dowel Bending Yield Strength Fyb
The program determines dowel bending yield strength for lag screws based on
screw diameter according to NDS 2005 Table 11K, Note 2, p 93.
e. Main Member Dowel Bearing Length lm
The penetration depth into the main member is used for dowel bearing length lm,
adjusted for lag screw tip according to NDS 11.3.4.
6. Withdrawal Design
Withdrawal design connection capacity applies to all implemented lag screw
connections.
a. Calculation of W
The program calculates withdrawal capacity for lag screw connections according
to NDS 11.2.1. at the time of calculating lateral design capacity.
b. Calculation of W’ - Adjustment Factors
The load duration factor CD, service condition factor CM, temperature factor Ct,
and are applied to are applied to the reference withdrawal design value W.
according to 10.3.2, 10.3.3, 10.3.4 , and to Table 10.3.1, to obtain the adjusted
withdrawal design value W’. The fire retardant treatment factor input by the user
is also applied.
c. Connection Capacity W’p
The value W is multiplied by the number of fasteners and the penetration depth
into the main member. The penetration depth p is that of the threaded portion of
the lag screw only, given in Table L2, and does not include the tip length; both
are according to Table 11.2A, headnote.
d. Design Routine
The program includes the withdrawal capacity in the search for a passing design,
cycling through unknown values if the withdrawal capacity does not exceed the
design load.
e. Output
The values of withdrawal load and resistance are given as P and W’p in the
design output.

7. Combined Lateral and Withdrawal Design
The program calculates combined lateral and withdrawal when there are both X- and Yloads on the purlin in the connection geometries that use lag screws
a. Calculation of Za
The program calculates combined lateral and withdrawal capacity for lag screw
connections according to NDS 11.4.1. The program compares this value with the
resultant load N to determine whether a connection passes.
b. Design Routine
The program includes the combined capacity check in the search for a passing
design, and also independently compares the Z with the lateral force Q and W
with the withdrawal force P. All three checks must pass.
c. Output
The values of the combined loading and resistance are output as Na and Za ,
along with the angle of resultant force with respect to the member surface, a . For
skewed connections, Na refers to a doubly combined load.
8. Secondary Wood Design Checks
a. Effective Shear Capacity
The program calculates effective shear capacity for perpendicular-to-grain lag
screw connections according to NDS 3.4.3. The calculation is the same as for
bolts, that is, it uses the worst-case effective depth over the width of the member.
The portion of the section where the screws do not penetrate is disregarded.
b. Tension Capacity Net Area and Group and Row Tear-out Capacity
None of the lag screw geometries contain tension loading parallel to the grain, so
these are not performed for lag screws.
9. Steel Design
In accordance with NDS 10.2.3 for fasteners in general, and NDS 11.2.1.3 for lag
screws in particular, the following steel design checks are performed:
a. Fastener Tension
The fastener tension check is performed using the root diameter Dr of the lag
screw and a lag screw steel tension strength that you can modify in Settings
initialisation file under the item LagScrewFt = [value in ksi]. Refer to the online
help.
The default value on the initialisation file is that for A307 bolts, 20.0 ksi, the
weakest given in Table J3.2, ASD Steel manual p 5-73.
b. Fastener Shear
The fastener shear check is performed using the full diameter D of the lag screw
and a lag screw steel shear strength that you can modify in the Settings
initialisation file under the item LagScrewFv= [value in ksi]. Refer to the online
help.
The default value on the initialisation file is that for A307 bolts, 10.0 ksi, the
weakest given in Table J3.2, ASD Steel manual p 5-73.
c. Fastener Bearing on Steel Plate
The bearing routine currently used for bolts is used for lag screws, using the full
diameter D to determine the bearing area.
d. Plate and Weld Design
All the existing design checks for strength of steel plates and welds that are
currently done for plates in bolted connections are also done for lag screws.
e. Washer Design
The program does not include washers for lag screw connections.
10. Design
a. Design Sequence

The order in which the program cycles through unknown input values to achieve
a passing design is given below, with items with asterisks representing design
checks new to lag screws:
Plate thickness
Diameter
Number of rows
Fasteners per row (except angle-to-grain loading)
Fastener spacing within row (except perpendicular loading)
Fastener length*
Check for protrusion*
Check for minimum penetration*
End distance (parallel loading only)
Fasteners per row (angle-to-grain loading)
Calculate lateral connection capacity
Calculate withdrawal connection capacity *
Calculate combined connection capacity *
b. Initial values
In order to avoid impractical connections with numerous small fasteners, if the
diameter is unspecified (unknown) the program starts with the initial value
specified in the Settings initialization file. If it cannot design using this or a larger
value, it tries smaller sizes.
This value can be changed in the Settings initialization as follows
[FacePlate]
LagScrewSize=1/2
The default value for new installations is ½".
11. Drawing
Lag screws appear in a similar diagram to the bolt diagram, except that the lag screw
penetration is shown via dotted lines in side view.
12. Text Output
The text output is the same as for bolted connections, with the following exceptions:
a. Fastener Sections
The fastener information is broken up into two sections: "Face Plate" and "Side
Plates" similar to shear plates as there are different types of fasteners used for
each plate.
b. Fastener Shear and Tension Capacity Fv and Ft
The Ft and Fv value for the lag screw input from the Connections initialisation file
are given.
c. Lag Screw Diameter
Lag screw diameter shows the full (not root) diameter of the fastener.
d. Lag Screw Length
Lag screw length shows the full length of the fastener, including tip and head.
e. Steel Design Checks
Lag screw steel design results are given by a success or failure message only,
as is the case with bolted connections.
f. Design results
The following design results are new to lag screw design
Withdrawal Load P (applied load in the X-direction)
Withdrawal Capacity W’p (product of W’, penetration depth p, and no of fasteners)
Combined Lateral and Withdrawal Load Na
Combined Load Angle a
Combined Lateral and Withdrawal Capacity Z’a

These are further discussed under Withdrawal Design and Combined Lateral and
Withdrawal Design.
Note that the symbols Na , and Z’a were invented for Connections in the absence
of a notation in the NDS.
C. Wood Screws
The program now includes wood screw fastener modules designed according to dowel–type
fastener design in NDS 2005 - Chapter 11, and specifically 11.1.4, 11.2.2 , 11.3 and 11.4.1.
Connection Modules
a. Available Geometries
The program limits the use of wood screws to two-member lapped shear
connections, to avoid the complication of overlapping penetration, and because
bolts are more commonly used in two-sided connections.
Two member splice, orthogonal, and skew geometries are therefore
implemented, for both wood-to-wood and steel-to-wood connection geometries.
Wood screws are not available for post-and-beam or ledger connections.
b. Method and Details Views
For these geometries, the wood screw option is available as a new choice in the
Connections Method view, and has it’s own set of Details.
Wood Screw Dimensions
The program uses the wood screw dimensions from NDS 2005 Appendix L, Table L3,
pg. 167 as follows:
a. Input parameters
Screw number and length are used as the choices of available input parameters.
They can be unknown, but are restricted to the standard wood screw numbers
and lengths (it is not possible to type in custom sizes). They are also restricted by
connection geometry.
The wood screw numbers available are 6, 7, 8, 9, 10, 12 and 14; the lengths
depend on screw number and were derived from a number of screw supplier
catalogues, taking into account availability, and commonness of use. The lengths
range from 1" to 12".
b. Design parameters
Diameter and root diameter from Table L2 are used for design. Length of the
tapered tip of wood screws is calculated as twice the diameter.
c. Drawing parameters
The head width is calculated as twice the diameter, and used for drawing only.
Geometric Limitations
The program implements geometric limits at the following times:
 upon validating the materials to determine the available methods for the
connection;
 during input to produce the drop-down lists of available fastener parameters;
 during design when resolving unknown values.
a. Spacing
The program applies spacing recommendations for wood screw connections
according to NDS Commentary Table C11.1.4.7. These recommendations are
used to populate the drop-down lists of fastener and row spacing and edge and
end conditions.
b. Protrusion and Minimum Penetration
The program prohibits wood screws from protruding through the main member
while ensuring they meet the minimum penetration of 6D into the main member,
according to NDS 11.1.4.6.
These rules are used to populate the drop-down lists of available screw
diameters and lengths.

User Interface
a. Methods View
Slightly different pictures are used for nails and for wood screw connections, and
labels have been added next to each selector button to avoid confusion. Titles
and descriptions were modified to refer to wood screws.
b. Details View
This view is the same as that for nails except for replacing nail type with wood
screw number. The available lengths are linked to the available wood screw
numbers. The lengths are also limited to those that satisfy the minimum
penetration and protrusion rules for the connection geometry; indirectly also
limiting the available diameters
Details view will not appear if there are no wood screws satisfying the geometric
limitations.
c. Preboring
According to NDS 2005 11.1.4.3, wood screws loaded laterally shall always be
bored. The Preboring control in the details view is checked, and made
unavailable (greyed-out).
d. Warning messages
All warning messages were changed to refer to wood screws when appropriate.
e. Status bar messages
All explanatory messages in the status bar were changed to refer to wood screws
when appropriate.
Lateral Design
a. Calculation of Z
The program calculates lateral design capacity Z for wood screw connections
according to NDS 11.3.1, in a similar manner to nails except as noted below.
b. Calculation of Z’ - Adjustment Factors
The load duration factor CD, service condition factor CM, temperature factor Ct
are applied to wood screw lateral connection capacity according to 10.3.2,
10.3.3, 10.3.4 respectively, and to Table 10.3.1. The fire retardant treatment
factor input by the user is also applied according to 2.3.4.
Note that the Cg factor and the CD factor are not applied to wood screws
because they are less than ¼" in diameter.
c. Diameter
Unlike nails, the root diameter Dr of the wood screw is used in the yield limit
equations in Table 11.3.1A, not the full diameter D.
d. Dowel Bending Yield Strength Fyb
The program determines dowel bending yield strength for wood screws based on
screw diameter D according to NDS 2005 Table 11L, Note 2, p 95.
e. Main Member Dowel Bearing Length lm
The penetration depth into the main member is used for dowel bearing length lm,
adjusted for wood screw tip according to NDS 11.3.4
Secondary Wood Design Checks
a. Effective Shear Capacity
Wood screws are not included in shear design according to NDS 3.4.3.3, and
therefore effective shear capacity is not calculated for wood screw connections.
b. Tension Capacity Net Area
Tension capacity, net area is not calculated for wood screw connections in this
version.
c. Group and Row Tear-out Capacity

According to NDS Appendix E.1.2, the effect of group tear out and row tear-out
capacity is not significant for smaller diameter fasteners. Since all wood screws
in the program are less than ¼" these checks are not performed.
Steel Design
The program does not perform steel design checks for any lapped shear connections,
including those fastened with wood screws.
Design
a. Design Sequence
The order in which the program cycles through unknown input values to achieve
a passing design is given below, with items with asterisks representing design
checks new to wood screws:
Wood Screw Number (Diameter)
Fastener length*
Check for protrusion*
Check for minimum penetration*
Number of rows
Fasteners per row
Calculate lateral connection capacity
b. Initial values
In order to avoid impractical connections with numerous small fasteners, if the
screw number is unspecified (unknown) the program starts with the initial value
specified in the Settings initialization file. If it cannot design using this or a larger
value, it tries smaller sizes.
This value can be changed in the Settings initialization as follows
[FacePlate]
ScrewNumber=10.
The default value for new installations is screw number 10.
Drawing
Wood screws for lapped shear connections only appear in face-view. The heads appear
as a white circle with a vertical slot.
Text Output
The text output is the same as for nailed connections, with the following exceptions:
a. Wood Screw Number
Wood screw number shows the wood screw size of the fastener.
b. Wood Screw Length
Wood screw length shows the full length of the fastener, including tip and head.
c. Steel Design Checks
Since no steel design checks are performed for wood screw connections, no
steel design check messages appear.
D. CAD Export
The program now allows you to export the drawing of a designed connection to a standard
CAD format: DXF (Drawing Exchange Format). For version 7.0 this feature is available only for
one-sided, beam-to-beam connections fastened with bolts.
The remaining post-and-beam connections will be made available via service releases to
version 7, as will shear plate and lag screw connections. Lapped shear connections will be
implemented in a future version of the program.
The WoodWorks development team welcomes any feedback on this feature to help in
implementing the rest of the modules.. Please send any comments or suggestions via email to
FeedbackConnections@woodworks-software.com.

Drawing Types
The program exports the drawing to three separate files containing different sets of
items exported for different end use.
a. Assembly Drawing
The program exports assembly drawings containing all components of a
connection (plates, fasteners, washers, and members), indicating how they are
assembled. It does not show the holes in the plates.
b. Shop Drawing
The program exports shop drawings used to fabricate the steel plates. These
drawings do not include the wooden members or fasteners.
c. General Drawing
This drawing contains all items components to allow the user to manually filter
what they want to appear. This drawing is needed, for example, to create a
drawing showing only the wooden members and the boltholes, to indicate where
the holes should be drilled.
DXF file format
a. Objects output
This version will export the line and text objects as DXF entities only. It does not
contain blocks or property tables
b. Grouping
The entities in the program will not be grouped – you will have to manually group
them if you want to move or alter the properties of elements en masse.
c. Object properties
Another consequence of exporting only entities is that shaded regions or dashed
lines are not exported with the first version of the CAD Export feature
User Interface
The program has a toolbar button, a menu item, and a hot key to allow the user to
invoke the export to the above-mentioned DXF files.
a. Activation
Both the button and the menu item become active after a design is performed.
The button and menu items are active only for connection methods currently
implemented for the CAD export feature.
b. Execution
Upon invoking the CAD Export, the program creates a drawing based on the
plates and fasteners designed with the last design run.
c. Output files
The following three DXF files are created in the same folder as the current
Connections project file upon pressing the hot key, selecting the DXF button, or
choosing the Export DXF menu item in the File menu:
[Connections project filename].dxf
[Connections project filename]asmbly.dxf
[Connections project filename]shop.dxf
Connection Types and Items Exported
a. Connection Types
For version 7x of Connections, the program will export bolted, lag screw, and
shear plate connections for post-and-beam geometries, starting with bolted
beam-to-beam for the initial release.
b. Items
The program exports plates, holes, bolts, dimension lines, members as thick
lines, and a limited information block. In upcoming service release updates,
shear plates and lag screws will be included. Lapped shear connections, nails,

wood screws and members as shaded regions await a future version of the
software.
Layout
a. Views
The program export a face view and a side view of the connection.
b. Scale
All objects are drawn to scale.
c. Vantage Point of Sections
The program renders a cut section as if a saw had been taken to the entire
assemblage at the point of section.
d. Shadowing
No attempt to render shadowing or obscuring of one object by another is made,
such as when the side of a bolt head in the side plate is in front the face of a bolt
head in the face plate.
e. Information Block
The program includes in the DXF file a small amount of callout information below
the connection drawing as text. This information includes members’ material and
size; quantity of plates, fasteners and washers; and size and grade of fasteners.
Layering
A complicated system of layering is included to allow for single plates to be isolated for
drawings for mass fabrication, but to allow for exclusion of the information found in
assembly drawings. For example, you might want to draw a particular plate, show the
holes but not the bolt heads, and also make sure that the bolt holes for all the other
(invisible) plates are not shown.
Therefore, there is a separate layer created for each combination of
 bearing plate, face plate, or side plate, AND
 holes; dimension lines; and fastener heads in face and side view.
There are also layers for
 fastener shank; washers; and callout information block.
Plates
a. Bearing Plate – Side Plate Gap
The bearing plate width and side plates are drawn in the export to include the
1/16" tolerance between side plate and member.
b. Holes
Holes are drawn in the shop drawing only and not in the assembly drawing. They
are sized 1/16" larger than the shank size of the fastener, in both face view and
side view, according to the table J3.1 p. 5-71 of the ASD Manual of Steel
Construction.
c. Welds
Weld sizes and specifications are not included in this version.
Fasteners
a. Bolt Size
The program draws bolt heads to scale according to sizes from NDS Appendix L,
p 165, which depend on bolt diameter.
b. Bolt Threads
Bolts are drawn with threads half the length of the bolt, starting at the nut and
washer end. The threads are not drawn to scale.
c. Bolt Head and Nut Thickness
The thickness of the bolt head is drawn as 0.675 x D (diameter), a number close
to the average of the thicknesses listed in NDS 2005 Appendix L p 165.
Nuts are drawn with a thickness of 0.875 x D as in Connections.

d. Washers
Washers are drawn only in side view of the assembly drawing, when there is no
backing plate. They are drawn as a solid rectangle with no lines to indicate the
hole.
e. Layout
The shank is drawn protruding beyond the nut by ½ nut depth so as to
distinguish the bolt head from the nut.
Members
a. Appearance
In the assembly drawing, members are drawn via a thick line on all edges, with a
thinner standard cut line shown where the members extend outside the drawing.
b. Interaction With Other Objects
Where a line is collinear with one from a plate, the thick member line is shown.
There is no attempt to hide or indicate via dashed lines when a portion of a
member is hidden by another member or a plate, and the member lines may in
some cases intersect with plates, holes or fasteners.
c. Holes
Holes are not ordinarily drawn in the assembly drawing. If you wish to create a
drawing showing the location of the holes on the wooden member, use the
drawing showing all items, and turn the plate and fastener layers, retaining
however the plate dimension lines.
Dimensioning
a. Dimension lines
The following items are dimensioned via dimension lines: Member width and
depth; plate width, depth and thickness for bearing, face and side plates; centreto-centre hole spacing, plate edge and end distance; position of plate on
member,
b. Callouts
The following items are dimension via callout text at the bottom of the drawing:
no. of bolts, bolt diameter, and bolt length required for face plates and for side
plates; washer diameter and thickness.
c. Placement
Dimension lines are nested as many as three levels as required. Sufficient space
for text is placed between nested lines.
d. Properties
By and large, the default CAD dimensioning properties are used for dimension
lines. An arrowhead is used by default (not a slash). The program set values for
the following properties, arrived at by experimentation:
text height
arrow size
Distance from text to dimension lines
Distance of start of extension lines from the object they are anchored to
Distance past the dimension line that the extension line goes
Unit system (imperial)
Format (fractional)
Round off precision (Closest 16th of inch)
E. Other Changes
Engineering Desing
a. Dowel Bearing Strength Fes of Steel Plate for Nailed Connections
Nailed steel-to-wood connections were being designed with Fes (dowel bearing strength
of side member) of 45,000 psi for ASTM A446 steel side plate, instead of Fes of 61,850
psi for ASTM A653 Grade 33 steel plate specified by NDS Table 11.3.2 footnote 2 .

User Interface and Results
a. Method screen
The depiction of fastener types in the Methods screen now have the names of the
connection methods written below the picture, to clearly indicate the choices being
made.
b. Capitalization in Results Output
Only the first word is now capitalised in the Results output section headings.
c. Capitalization in Details View
Only the first worid Is now capitalised in the labels in Details view.
d. Details View Bolt Diameter Units
The "Bolt Diameter" label in Details View has been changed from units as "inches (mm)"
to (inches), as the items in the drop-down box are displayed in inches.
e. Combined Load Symbol
The prime notation (') nas been removed from N', the combined load for a skewed
beam-to-beam connection, in the Results Output. N' refers to combined resistance.

Version 2004a - October 29, 2004 - Design Office 2004 Service Release 1
1. Help
a. Help and Key code Dialogs
 Contact information for sales and support was updated.

Version 2004 - December 15, 2003 - Design Office 2004
1. Connection Design
a. Row Tear-out
 Determine row tear out capacities for bolted and shear plate connections as per
NDS 2001 Appendix E.
 The row tear-out is calculated for each connecting wooden member that is
loaded parallel to grain after checking the connection capacity and the net area
tension capacity check. The row tear-out capacity is reported in the Design
Results section for each applicable member.
b. Group Tear-out
 Determine group tear out capacities for bolted and shear plate connections as
per NDS 2001 Appendix E.
 The group tear-out is calculated for each connecting wooden member that is
loaded parallel to grain with more than 1 row of fasteners, after checking the
connection capacity, the net area tension capacity check, and the row tear-out
capacity check. The group tear-out capacity is reported in the Design Results
section for each applicable member.
c. Effective Depth Provisions
 The effective depth calculations now calculate effective shear for connections
less than 5 diameters from the end of the member.
d. Dowel Type fastener design
 The program now treats Nails and Bolts as dowel type fasteners as per the NDS
2001 Chapter 11.
 Nails greater than 1/4" diameter designed differently as a result.
 Include table of yield mode values for dowel-type fasteners in design results.
e. Modification Factors





The wet service factor, Cm, for connections is now implemented as per NDS
Table 10.3.3.
Allow the user to specify the In-Service and the At Time of Fabrication moisture
contents.
Include table of strength modification factors in design results

2. Materials
a. Nails




Updated to new nail types and sizes as per ASTM F1677.
Sinker nails have been added and Threaded nails have been removed from
Connections.
Added nail pre-bore diameters to design check output

b. Steel




The minimum steel plate thickness has been enabled in the settings ini file.
It allows a minimum of 1/8" steel plates.
Updated steel strength to NDS 2001 value in Table 11B,D,G,I.

c. Wood



Updated database shear strengths to NDS 2001 Supplement values.
Modified glulam to have shear capacity factored by 80% for connection shear
checks (NDS 2001 Supplement note 3)
 Added lapped shear materials to database editor to allow the enabling/disabling
of materials allowed in lapped shear connections.
3. Program Operation
a. Messages
 Added note to output for lapped shear connections loaded perpendicularly,
"Designer is responsible for checking the shear capacity of the member"
 Modified reporting of overlap length for ledger connections.
 Updated wording of messages and strings.
b. Initialization File Settings
 The .ini file can now be accessed from the Connections View menu.
4. Bug Fixes
a. Lapped Shear Connections
 Wood-to-wood orthogonal connections used to crash with bolts < 3/4"
 Wood-to-wood connections Cg, and Cdelta calculations were not properly
examining the wood side member
 Bolted lapped shear connections loaded in compression passing even though
capacity is insufficient.
 Orthogonal wood-wood connections loaded only in the X direction was orienting
the rows of bolts in the wrong direction.
 Wood-Wood connections with one hard lumber member and one soft lumber
member was not taking the calculating Cdelta correctly for the side member's
end distance.
 Ledger connections loaded in Y direction were generating incorrect Z' values.
 For ledger connections, selecting a row spacing had no effect on the design.
b. Other bug fixes:
 Incorrect steel factor for shear plates was being used in calculations, NDS 2001,
Table 12.2.4.
 Selecting Grade - No. 2, Species - Southern Pine, Material - Soft Lumber, would
revert to No. 2 Non Dense.
 Reporting of user selected temperature in design results was incorrect.
 Plates not requiring design were being reported as a failed design
 Wet service factor Cm for dimension lumber with Wet In-Service condition was
using Cm for shear of 0.96 instead of 0.97

Version 2002 - Oct 26, 2001 - Design Office 2002
Change version to 2002 so that it works with 2002 key codes

Version 2000b - Jan 9, 2001 - Design Office 2000 Service Release 2
New Key code system - refer to the Key Code Security section above for details.

Version 2000 - Feb 18, 2000 - Design Office 2000
1. Lapped Splice Bolted Connections
The generalized geometry currently used for nails has been extended to bolts. The
program designs right angle connections with loads in both directions, sloped connection
with load parallel to the side member, and splice connections using bolts. It automatically
places the bolts in the intersection of the members according to the spacing rules.
2. Wood to Wood Bolted Design
The program determines resistances for wood to wood lapped splice connections. It
previously designed only steel to wood connections for bolts.
3. Steel to Wood Lapped Splice Connections
For both bolted and nailed generic connections, it will be possible to design a steel plate
entirely within the boundary of the wooden member. This will facilitate splitting of
complicated connections into their component parts.
4. 3-member Connections
Bolted connections are able to have two steel or wood side members with a wood main
member, or a steel main member with wood side members. Three wooden member nailed
connections are also implemented.
5. Greater Range of Angled Connections
For both nails and bolts, there is a larger sweep of angles possible in the "skewed"
connection. The user can specify and angle from zero to 180 degrees, making it possible to
design trusses more accurately.

Version 99 – Feb 4, 1999
No information available about this release.

Version 97b – Apr 22, 1998
No information available about this release.

Version 97a - March 11, 1998

NDS 1995 has been added to the Help menu. Selecting it will automatically start Acrobat Reader
which is required for viewing the electronic version of the NDS manual.

Version 97 – Feb 1, 1998
Added steel design of plates, washers, and bolts for shear, tension, and bearing.
Added skewed, orthogonal and spliced generalized “lapped shear” connection geometries, using
nails, which are also new to the program.

Version 1.0 - August 15, 1995
Original version with beam-to-beam, beam-to-column, and column-to-base connections using bolts or
shear plates as connectors, and beam-to-beam top hanger connection.

